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Section 1 - Getting Started With
CEENBoT Commander

o Getting Familiar with Your Robot and Programmer
o Software Installation
e Programmer Installation
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Getting Started

Introduction

This Getting Started guide helps novice robot programmer understand, install and use

CEENBoT Commander for basic CEENBoT programming. The guide will familiarize you with

concepts, techniques and definitions for programming robotic devices.

You will be introduced to the hardware programmer device (AVRISP MKii) and CEENBoT
Commander graphics program interface (GPI) software which allows you to connect to and

program your robot.

What is a CEENBoOT?

The CEENBOT is a robot designed and built at the University of Nebraska for use in K-12

classrooms, post secondary education and after school programs.

CEENBoT History

The original purpose of the
CEENBOoT educational platform was
to create interest in the curriculum
for engineering students at the
University of Nebraska, and improve
student retention rates in
engineering programs.

Building upon its initial success at
the University, the CEENBoOT has
been introduced into middle and
high schools in Nebraska to interest
young learners in science,
technology, engineering and math
(STEM) and increase the number of
students pursuing STEM careers.
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The CEENBOT provides students exposure to engineering and programming experiences.
Teacher-developed educational materials for grades 5-12 support the use of CEENBoTs for
STEM labs and classroom work.

CEENBoT Components:

Although the CEENBOT’s design has changed over time, all CEENBoTs have the similar
components. The main parts of a CEENBoT are also similar to nearly every other robot you
may encounter.

Robot Chassis: The part of the robot where all other pieces are mounted. It provides
structure and stability for motors, sensors, electronics, batteries, and optional parts like
robotic arms.

Robotic Controller PCB: A printed circuit board containing the microcontrollers and the
electronics to control motors, display information, and interact with its surroundings.

Infrared Proximity Sensor: A device that emits an infrared beam and detects the reflection
of from objects in front of the robot. A common use is to avoid collisions with objects or
walls or to navigate a maze.

Motor: A motor turns electricity into rotation of a shaft. Put wheels on the shaft and your
robot can move under your control. CEENBOTSs use stepper motors, which turn in small,
consistent angular movements rather than continuously. The CEENBoT stepper motors turn
1.8° with each step. A full revolution takes 200 steps.

Wheels: Plastic wheels with rubber tread turn the rotation of the stepper motors into
motion.

6|Page



CEENBoT Commander Programming Guide 1.20

CEENBoT Robotic Controller PC Board

The microcontroller board on the CEENBOT is based on the Atmel ATmega324P
microprocessor. The board has switches, lights connectors and a display to give you several
ways to interact and work with your robot.

Reset LED:
Switch Led5, Led6

Off/On Switch Switches: LCD Panel ISP
S3, S4, and S5 Connector
Qty Feature Purpose Programmability
1 Off/On switch Turn robot on and off
1 LCD panel Show text and graphics Display from program
3  Input switches: S3, S4, S5 User input from switches Read by program
1 ISP connector Align pin 1 with red stripe
2 LEDs: D2, D3 Programmable Control from program
1 Reset switch Restart controller software
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Installing the CEENBoT Commander Program for Windows

Download and install the setup program to your hard drive.
Double click the downloaded file and follow the prompts. Click next.

5 Setup - CEENBoT Commander

Welcome to the CEENBoT
Commander Setup Wizard

This will install CEEMBoT Commander version 1.2.0 on your
cornputer.

1t is recommended that you close all other applications before
conkinuing.

Click Mext to continue, or Cancel to exit Setup,

I pext> | [ Cancel

5 Setup - CEENBoT Commander

License Agreement

Please read the following important information before continuing.
Please read the following License Agreement, You must accept the terms of this
agreement before continuing with the installation.
CEENEoT Commander Licensing Informnation s
CEENEoT Commander iz icensed under the Berkeley Software
Distribution (B3D0 License. License information 15 copied mnto
the CEENEoT Commander Directory
The CEENBoT Commander application is built upon Java and

e d VT imicn T i st £rae 0
()1 do not accept the agreement:

< Back. H Mext = ] [ Cancel
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Check both CEENBoT Commander components UNLESS you have AVR Studio already
installed on your computer.

1. WinAVR v20100110
2. AVRISP MkIlI USB Driver

Note: The CEENBoT Commander AVRISP Mkll USB Driver is incompatible with the driver
provided with AVR Studio. Contact us if you have this situation.

Click “Next”.

5 Setup - CEENBoT Commander

select Components
which compaonents should be installed?

Select the components vou want to install; dear the components vou do not want. to
install, Click Mext when vou are ready ko continue,

Cushom installation w

WINAYR v20100110 (needed
LibUISE AYRISP MKII LISE Driv

projects) 278.9 MB
d ta transfer pragram)

Current selection requires at least 242, 1 ME of dick space,

< Back ” et > }[ Cancel

Allow the application to create a desktop icon. Click next.

<
ﬁ! Setup - CEENBoT Commander EI_‘&J

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing CEENBoT
Commander, then dick Mext.

Additional icons:

Create a desktop icon!

< Back ]I Mext = l[ Cancel
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The setup process will display a Ready to Install box which explains what applications and tasks

will be installed on your computer. Click next.

Ready to Install
Setup is now ready to begin installing CEENBoT Commander on your computer,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Setup type:
Full installation

I Selected components:
Required Ceenbot Commander files
WinAVR v20100110 {needed to compile projects)
AVRISP MKII USE Driver {(needed to transfer program to robot)

Additional tasks:
Additional icons:
Create a desktop icon

<Back | Install |[ Cancel

F |
ﬁ! Setup - CEENBoT Commander El_‘éj

5 Setup - CEENBoT Commander

Installing
Please wait while Setup installs CEEMEOT Commander on your computer,

Extracting files...
C:\Program Files\Ceenbot\CEENEaT Commanderibintlibisubstance. jar

[

The setup process will ask you to select the language. Click OK.

F |
Installer Language [&J

@ Please select a language.

|Engiish -

[ OK J l Cancel ]

The Commander installation should be complete.
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Next you will be prompted for the WinAVR 20100110 installation. Click next.

Welcome to the WinAVR 20100110
Setup Wizard

This wizard will guide you through the installation of WinAVR.
20100110,

Itis recommended that you cose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue,

Agree to the software license agreement.

VR 20100110 S

License Agreement
Please review the license terms before installing WinAVR 20100110, @

Press Page Down to see the rest of the agreement.

'WinAVR Licensing Information -

GNU Binutils is distributed under the GNU GPL License,

GNU Compiler Collection (GCC) is distributed under the GMU GFL License.

@vr-ibc is distributed under a BSD License,

avrdude is distributed under the GNU GPL License,

GMU Debugger (GDE) is distributed under the GNU GFL License.

Insight is distributed under the GMNU GPL License

SimUIAVR. is distributed under the GNU GPL License

AVERICE is distributed under the the GNU GPL License. -

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install WinAVR 20100110,

< Back ” I Agree ] I Cancel

Use the default destination folder to install WinAVR 20100110.

Choose Install Location
Choose the folder in which to install WinAVR 20100110,

Setup will install WinAVR 20100110 in the following folder. To install in a different folder, dide
Browse and select another folder. Click Next to continue.

Destination Folder

| Browse...

Space required: 262, 2MB
Space available: 485.3GB

Next = ] [ Cancel
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Choose the components of WinAVR 20100110 you wish to install. We recommended you
select all the components for installation.

' Choose Components

Choose which features of WinAVR 20100110 you want to install.

Chedk the components you want to install and uncheck the components you don't want to
install. Click Install to start the installation.

Select companents to install:
Add Directories to PATH (Recommended)
Install Programmers Notepad

Space required: 252.2M8

[ < Back ][ Install ][ Cancel

The setup program will install WinAVR 20100110. Installation is complete.

' 015 e T e
Completing the WinAVR 20100110
Setup Wizard

WinAVR 20100110 has been installed on your computer,

Click Finish to dose this wizard.

5 Setup - CEENBoT Commander

Completing the CEENBoT
Commander Setup Wizard

Setup has finished installing CEENBoT Commander on your
computer. The application may be launched by selecting the
installed icons.

Click Finish ta exit Setup.
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After installation completes, a web page will open to display information about WinAVR. Most
people will not need this information and the web page may be closed.

You have now installed the Commander, WinAVR, and AVRISP MKII applications and are
ready to start programming your CEENBoT.
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Installing the CEENBoT Commander Program for Apple OSX
Snow Leopard

CEENBoT Commander is supported on Apple OS X version 10.6 (Snow Leopard) on all
machines and version 10.5 (Leopard) on 64 bit machines. The operating system and Java
should be updated with current patches.

CEENBoT Commander is delivered in a .dmg installation file. Contained in that file you will find
two components:

1)The open source package CrossPack AVR development tools, and

2) The CEENBoT Commander program

Download the CEENBoT Commander Install .dmg file to your hard drive.

S 0 = <) Fri 917 AM

CEENBoT
lGomm...ll.dmg

Figure 1 - CEENBoT Commander dmg file on desktop
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Double-click on the CEENBoT Commander Install .dmg file to open it on your computer. The
newly opened file will appear as a folder on your desktop.

A ¢ = ) Fri 17 AM.

CEENBoT
Comm...ll.dmg

CEENBoT
_Comm... Install

Figure 2 - CEENBoT Commander Install Folder

Open the CEENBoT Commander Install folder.

© O O || CEENBoT Commander Install =5
6.7 ME available —G—

PRRMAARESY: CrossPack-AVR.pkg

CEENBoTCommander
" RTF
__RTF__ CrossPack-AVR-
CEENBoT Commander Readme.rtf

Install ReadMe

&
Figure 3 - CEENBoT Commander Install Folder Contents
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Double-click the CrossPack AVR by double-clicking on CrossPack-AVR.pkg.

Yele & Install CrossPack-AVR 20100115

Important Information

& i roducion Getting Started with CrossPack
© Read Me for AVR Development

® Destination Selectf CrossPack for AVR Development has no Graphic User Interface, it

consists of command line tools only. For help with the package, type
“avr-help®in a Terminal window. This opens the manual in your favorite
® Installation web browser. An alias to this manual is also created in the Applications

falder during installation.

® Installation Typef# -

@ Summary

(" Print.. ) [ Ssave. ( CoBack ) ( Continue )

Figure 4 - CrossPack Installation Initial Screen

Install CrossPack in the default location

Yale « Install CrossPack-AVR 20100115

Standard Install on “meMac”

© Introduction

© Read Me 4 This will take 102.4 MB of space on your
computer.
© Destination Select

Click Install to perform a standard installation of

 Installation T'
Y b | this software on the disk "meMac”.

® Installation

® Summary

v

(" Change Install Location... )

( GoBack ) [ Install )

Figure 5 - CrossPack Configuration / Install Screen
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The CrossPack installation program will show its progress.

e

'« Install CrossPack-AVR 20100115

8 Introduction

& Read Me

© Destination Sele
@ Installation Ty
 Installation

® Summary

Installing CrossPack-AVR 20100115

Moving items into place...

3 Co Back_

-_g_ontinue ’

Figure 6 - Crosspack Progress Screen

The CrossPack installer will show a success screen when done.

|nn

« Install CrossPack-AVR 20100115

& Introduction
© Read Me

@ Destination Sele

& Installation Ty
& Installation

9 Summary

The installation was completed successfully.

. 3

The installation was successful.

The software was installed.

Go Back_

Figure 7 - Crosspack Completion Screen

( Close )
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Drag the CEENBoTCommander icon to your Applications folder.

S

CEENBoT Commander Install

| 6.7 M8 available —C—
|
|

CrossPack-AVR.pkg

208 (2] Applications = | - 1
(o] (s ] 3 | o= >

CEENBoTCommander

|| CEENBOT Commande... &
wre CrossPack-AVR-

CEENBOT Commander Readmeitt,
Install ReadMe

SHARED

[ buzz =
B monteserver

[ pa-03

& pi7a

B usbshare

Name a
Address Book
@ App Store

PLACES
A Desktop
Y Jeffi755

Application

Apr 2, 2011 9:02 AM Application

& Automator Jul 11, 2009 2:09 AM Application
Calculator Jul 6, 2009 1:17 AM 9.5 MB Application
71 Documents
=2 CEENBoTCommander Feb 18, 2011 11:51 AM 17.3 MB Application
SEARCH FOR 2 Chess May 19, 2008 1:09 AM (= 3.8MB  Application
1) Today ) CrossPack-AVR-Manual html Feb2,20117:37PM cowwnmin  4KB  Alias
L Yesterday @ Dashboard Apr 2, 2011 9:02 AM 205KB  Application
T Past Week B Dictionary Apr 2, 2011 9:02 AM #MB  Application
(5] Al images [ DVD Player Jul 14, 2009 4:05 AM 32.2MB  Application ]
(5] All Movies @ Firefox Apr 3, 2011 11:45 AM S5.9MB  Application
(3] All Documents Font Book May 5, 2009 1:04 PM 14.5MB  Application
& Front Row Apr 2, 2011 9:02 AM 401KB  Application i
= ical Apr 2, 2011 9:02 AM 53.6 MB___Application v

1 of 34 selected, 481.37 G available

X

Figure 8 - CEENBoT Commander Drag and Drop Installation

You have now installed Commander for Apple OSX.

To run CEENBoT Commander, double-click on CEENBoTCommander in the Applications
folder.

an6o (23] Applications 3
(22 [ = [m I Q :
DEVICES
___, meMac
£l iDisk

.| CEENBoT Commande...

SHARED
I_;-J buzz
|| monteserver CEENBoTCommander
] pa-03
= pi74
L;-J usbshare
PLACES Name 4| Date Modified Size Kind
A Deskiop \__ Address Book Apr 2, 2011 9:02 AM 18.6 MB Application
& jefi755 tai App Store Apr 2, 2011 9:02 AM 7.4 MB Application
= ' Automator Jul 11, 2009 2:09 AM 14.8 MB Application
Calculator Jul 6, 2009 1:17 AM 9.5 MB Application
Documents
: ~ CEENBoTCommander Feb 18, 2011 11:51 AM 17.3 MB Application
ARCH FOR 4. Chess May 19, 2009 1:09 AM 3.8 MB Application
=) Today i) CrossPack-AVR-Manual.html Feb 2, 2011 7:37 PM 4 KB Alias
1) Yesterday @ Dashboard Apr 2, 2011 9:02 AM 205 KB Application
(L) Past Week B Dictionary Apr 2, 2011 9:02 AM 7 MB Application
m All Images ; DVD Player Jul 14, 2009 4:05 AM 32.2 MB Application
Al Movies @ Firefox Apr 3, 2011 11:45 AM 55.9MB  Application
m All Documents *: Font Book May 5, 2009 1:04 PM 14.5 MB Application
' Front Row Apr 2, 2011 9:02 AM 401 KB Application i
10 ical Apr 2, 2011 9:02 AM 53.6 MB  Application v

1 of 34 selected, 481.37 GB available

Figure 9 - Running CEENBoT Commander
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AVRISP Programmer

The AVRISP Programmer
allows the computer to send
new programs to the CEENBoT.
Each time you send a new
program to the robot, the old
program is overwritten. The
AVR Programmer connects
between a computer USB port
and the CEENBOT in-system
programmer (ISP) port.

The AVRISP programmer
requires a software driver to be
installed on your computer.

On Windows machines, the
programmer requires the driver to
be set up for each unique AVRISP
mkll programmer (for example in a
classroom) and USB port
combination. We recommend
using the programmer in the same
USB port each time.

The software driver is installed at
the same time as CEENBoT
Commander. If you have not yet
installed CEENBoT Commander,
please install it now. Your
computer will not recognize the
programmer when it is plugged in
without first completing the
installation.
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Setting up the AVRISP programmer driver:
1. Connect the USB cable into the USB connector on your computer.
2. Plug the other end of the USB cable to the AVRISP programmer. Once connected for
the first time, the computer will recognize the new device and install the software driver.
This may take a couple minutes to complete.
3. Connect the ISP cable to the ISP connector on the PC board. Make sure pin 1 on the

ISP plug (red stripe) is lined up with pin 1 on the PC board (see figure 4).

The AVRISP programmer is ready to use when the LED near the robot is lighted green and no
other colors or LEDs are lighted

Computer USB Status Light

No Light Normal inactive state. The LED may flash when the programmer is first
plugged in and then go out.
Flashing Green Sending data.

Robot ISP Connection Status Light

No Light Programmer has not been connected to a robot before, or drivers not
installed correctly.

Green Connected to the robot, and the robot is turned on.

Orange Programming the robot. Do NOT disconnect any cables while orange.

Red Connected to the robot, but the robot is turned off.

Flashing Orange Pin 1 (red stripe on cable) not aligned with pin 1 on PC Board.
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CEENBOT ISP connector and AVR Programmer

ISP
Connector

Align pin 1 with
Red Stripe on
cable

Computer USB Status Robot ISP Connection Status
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Section 2 - Programming With
CEENBoT Commander

—

Getting Familiar with CEENBoT Commander
Starting to Use CEENBoT Commander
Programming Tools

Programming Techniques

Configuring CEENBoT Commander Options
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CEENBoT Commander Graphical Program Interface (GPI)

This Programming Guide will show you the parts of CEENBoT Commander you will want to
know about, the commands that can be used to create your programs, and the settings for each
command to make your robot behave the way you want. CEENBoT Commander is a graphical
program interface, which means you can write a program by dragging and dropping commands
onto a window rather that writing programs with words. Start CEENBoT Commander by clicking
or double-clicking on the program icon.

Starting main program...

=3

CEEMEQT
ommander

As the program is loading, a splash screen
will display. On the first startup after
installation, you may be prompted whether
you wish to always check for program
updates when Commander starts.

Subsequent startups will not ask this question

[Tarast | Took | Tretes || smpearance although you can change your preference in the
“File” > “Options” > “Updates” window.

[] Check at Startup
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GPI Overview

The CEENBoT Commander screen contains several areas that are used when programming

Menu Bar Menu based controls grouped by File, Edit, Project, View, and Help.

Icon Bar Buttons that provide one-click access to frequently used controls.

Tool Box Programming commands are grouped by Input, Output, Flow Control, and
Variables.

Main Window where the tool program commands are arranged into programs.

Tool Window
o Tool View Show and change the arguments of the selected tool program element.
o Description Helpful information on how to use the selected tool.

B2 New_Project - CEENBat Commander - [Mew Document*]

Start Tool (€1

‘\ —

Tool Box

I - i
|_Tomol viewe | Dascription [£] 12

Main 1 =
1
et Tool View

Nothing Selected
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Using CEENBoT Commander

CEENBoT Commander is designed to simply and easily program a CEENBoT robot. Most
activity starts at the Icon Bar, where you can create a new project, open an existing project,
save your work, and program your robot.

Icon Bar Features

3 EH M & > | = | @
rrrrrrtrrorra

1. Create a new project

2. Open an existing project

3. Save the current project

4. Build and upload project to robot

5. Build the current project

6. Upload project to robot

7. Options

8. View C code

9. View graphically

10. Add a new module to the current project

In the next few steps, we show you how to start writing your program and send it to your
CEENBOoT robot. We begin with creating a project. A project contains the main program and
any modules that make up the entire set of instructions for a robot.

Creating a New Project

Click on the icon bar:

0 y |__j o A & | (=] *)

Create a new project.
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Select or create a folder to hold the project. Type a file name for the project. The name can be
the same as the project folder, or could be something different.

H Create New Project [g|

e [Srer o ElNEEEE

Use a folder for each project

Type a name for the
project

File Mame: | Movelt & |

Files of Type: |CEEI"-JEh:|I: Commander Project (%,cop) | W |

Choose AVR as the platform. CEENBoT Commander is designed to work with different robots.
Your robot is based on the AVR family of microcontrollers. This should not be changed.

Choose Platform
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loaded.

programming.

NOTE: Programs Start Running Immediately!

o Programs uploaded to the robot start immediately after they are
e The robot wheels should not be touching the floor or table top while

e Place the robot on a block of wood or have your partner hold the
robot. Otherwise the robot may start moving unexpectedly.

Open the Output group in Tools.

Drag and drop the Delay tool and
attach it to Start.

Click on the Delay tool block and
enter 1000 milliseconds in Tool
View.

Drag and drop the Move tool and
attach it to Delay.

Click on the Move tool block and
enter move arguments in Tool View
as shown.

File Edit Project Yiew

Help

1< 4
[ Flow Contral
[ Wariables

Mo

Left Wheel Movement

Left Wheel Speed (%)
() Variable

@ Constant

i} 50

Right “Wwheel Movement

Right Wheel Speed (%)

() Variable

@ Constant
u] 50 100
Run Mode
[remmivg [

Forward v

113 samplevar v

113 samplevar v

0

I

100

e HE s NS EE|O
|
1ol ‘, ForwardRal_main
# Input
= Oukput
¢ Delay SHEL J
= - —
.__:":;_. Move De‘I:;/ =
1.0s"
EServo S
'4") Sound Move E’Q‘
iy LEDs "
E._.I Displaw
comment
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Build and Upload Project to Robot

Now that you’ve created your program, you will want to save and transfer it to your robot. The
Build and Upload icons will allow you to do this.

1 2 3

1. Build and upload project to robot
2. Build the current project
3. Upload project to robot

Pre-Upload Checklist
o CEENBoT Commander will ask you to name your file and project if you have not already
named it.
e CEENBoT Commander will save your file automatically before building it.
o Be sure the robot wheels are not touching the floor or table top
o Be sure the robot is powered on
e Be sure the AVR Programmer is properly connected to the computer and robot
o Be sure the robot status light on the AVR Programmer is green

When everything is ready, click on the icon bar: Build and upload project to robot. The
computer USB status light will start blinking and the robot ISP status light will turn orange.

After the program is transferred, the robot will start running it. Watch the robot while testing
your program. Remove the ISP connector so the robot can run freely.

The program will run one time after the upload finishes. To run the program again, press the
Reset button on the PC board or turn the robot off and on.

NOTE: Programs are Stored in Flash Memory

The robot can be powered off since the robot programs are saved in the
robot flash memory. When the robot is powered on, this program will start
running immediately.
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CEENBoT Commander Tools

Start Tool
- The Start Tool marks the = L — -
Start J beginning of the program Tol § [Fornaral o |
N chain. All other tools attach f:)”ftfut |
to it. CEENBoT Commander :zv;;::tm' _Sth
automatically places the Start tool on a new . Nz
project.

Variables are also added to the program using
the start tool. These variables can be used by
other tools. et

Yariables

samplevar

There are two kinds of variables: Integer and

Boolean.
Type 123 Integer |v
. Initial Yalus |123 Integer |
Integer values must be in the range 011 Baclean
Save HEmoveE
-32768 up to 32767 with no decimal..
=Stark
Yariahles
sampleyar
Boolean values are either TRUE or
FALSE, and the two values are
- ] interpreted as False = 0 and True = 1.
.
Tnitial Valug I:l Wariables
Remove samplevar

Type 0/1 Boolean
Remove || age
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~Toals
Input Tools
= Inpuk
= .
AR Proximity
] Switch
“ 2.y Remoke
[ Oubpuk
#  Flow Contral
F  Variables

Proximity Tool:

) Reads the status of left and right infrared proximity sensors and copies this into
"’“i'"itﬂil a Boolean variable. If the sensor is obstructed, the variable will contain a value

Too Close

= of1(e.g. true). If the sensor is unobstructed the variable will contain zero (e.g.

false).
~Proximity
-Sensar
o [v]
~Wariable
|ll|1 TooClose |v|

Switch Tool:

_ ! Reads the status of one of three input switches on the controller board, and
Switch 5 §JJ copies this into a Boolean variable. If the switch is depressed, the variable
ShttonPres will contain a 1 (e.g. true). If the switch is not depressed, the variable will
) contain zero (e.g. false). The switch number corresponds to a switch on the
physical board. See chart below.

~Switch
Yariable Platform | Switch | Label | Position
| 0|1 ButtonPress | w | 3 53 Left
Switch 324 4 54 Center
5 55 Right
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Remote Tool:

: Reads the values received from the " rRemate
Remote -, Playstation remote control and puts -Selected Inputs
_v selected values into pre-defined
variable (pre-defined means you don’t Enabled Name
have to set up these variables in the 0 o
Start tool. 0 i
To use the remote tool, drop it onto the main screen. U Lt
Check the remote input or inputs you want to use, and [ Lz
the variables will appear in variable selection boxes = L3
along with the other variables you created. = Rl
™| RZ
™| R3
™| digital up
™| digital dowir
™| digital left
™| digital right
™| triangle
™| square
™| circle
™| e
™| left stick leftiright
™| left stick upfdown
™| right stick left/right
™| right stick updown
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Some remote variables are Boolean (true or false) and others are integers

Boolean Variables Integer Variables
(True or False, 1 or 0) (-128 ... 127)
Button Variable Name Button Variable Name
select PSX_select left stick left / right | PSX_lstick_Ir
start PSX_start left stick up / down | PSX Istick_ud
L1 PSX L1 right stick left / right | PSX rstick Ir
L2 PSX L2 right stick up / down | PSX_rstick_ud
L3 PSX L3
R1 PSX_R1
R2 PSX_R2
R3 PSX_R3
digital up PSX dup
digital down | PSX_ddown
digital left PSX_dleft
digital right | PSX_dright
triangle PSX_triangle
square PSX_square
circle PSX_ circle
X PSX_X

To use the left and right stick controls with integer variables and analog outputs (from -128 to
127), the remote MUST be in Analog mode and the red light below the “Analog” button on the
remote must be illuminated.
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Output Tools

Delay:

Delay =
l].l.'la;]

~Toals
Impuk
= Oukpuk
=
Drelay
_—
L0 Maove
g
E Servo
q-lj Sound
.y LEDs
B
_ _'1‘| Display
" Comment
#  Flow Conkrol
#  Wariables

value (a constant), or by an integer variable value.

~Dielay

() Mariable

113 waitasec

Duration {0-32,000 milliseconds)-

16000

32000 1]

~Delay

The delay tool is used when the robot needs to pause for a set amount of
time. The delay is measured in milliseconds, or thousandths of a second.
1000 milliseconds equals 1 second. The Delay duration can be set by a fixed

Duration (0-32,000 milliseconds)

w @ Variable 123 wailkasec

() Conskant:

1a00a

F2000

s00
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Move
The move tool is used to make the robot motors turn. Each motor is
Ak " controlled independently.

Settings for Left Wheel Movement and Right Wheel
Movement control how the corresponding wheel will turn.

e Forward and Backward spin the wheels at the
specified speed until the specified distance has
been traversed.

¢ Brake will lock the wheel in place until a different
Move instruction is issued.

¢ None causes the wheel to stop, but it does not lock.

The Left Wheel Distance and Right Wheel Distance can be
set by the tool slider or by a variable to control how far the
robot will go, in terms of 1/10 motor revolutions (deci-
revolutions). The maximum is 200 deci-revolutions.

The Left Wheel Speed and Right Wheel Speed can be set

by the tool slider or by a variable to control how quickly the
wheels turn, where 100% indicates that they spin as fast as
possible.

Finally, Run Mode provides an additional modifier.

o The default mode is Blocking, which tells the
program to wait until the motors have moved the
desired distance. This mode would be used to
precisely control the distance traveled

¢ Non-blocking mode tells the program to keep going
to the next command even while the motion
command is performed. This mode can be used
along with an input command to avoid a collision or
play a tune while moving.

e Freerunning mode behaves similarly to non-
blocking, except the wheels will keep turning forever
or until a new move command is performed.

=Miove

Left Wwheel Movement

Forvad [V

Left Wheel Distance (deci-Rewvs)
() Wariable | 123 samplevar
@ Constant

W
L

1] 100 200

~Left Wheel Speed (%)

() Wariable | 123 samplesar v
@ Constant
ped
L ¢ ; ; ; I ; ; - '.lJ
0 50 100

Right ‘Wheel Movement

Fevard V|

Right \Wheel Distance (deci-Revs)-
() Yariable | 123 samplevar

@ Constant

W
I\(}I —— ....I

|
1] 100 200

Right \Wheel Speed (%)

() Wariable | 123 samplevar v

® Constant

P

1] 50 100

Fun Made

| Blocking | W |
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Servo:

Servo l.‘l

. The Servo tool is used to control up to five servos connected to the controller
an® J

board. A servo is a special kind of motor that does not rotate freely, and
instead turns to a precise, repeatable rotation position like hands on a clock.
Servos are used on radio control airplanes and cars to steer, fly and adjust
throttle settings, and are also used on robotic arms.

Each Servo tool on the main screen can control one of
five servos. A dropdown lets you pick the servo to

=SEryo

Servo Mumber

control. a0 |w
Paosition () ID_—|
® Variable 123 ElbowFle ;
() Constank 3
4
1] N 150

Calibration Offset { #)
Servos are set to rotate from 0 to 180 degrees through

use of a variable, or through a constant with the tool
slider or the entry window.

FoErYD

~SErYo

Servio Number Serva Mumber

o ||
Position { #)- Position [ #)
@ ‘Yariable 123 samplevar | W | () Yariable 123 samplesar "
() Constank n @ Constant
0.0 0.0 180,0 0.0 Q0.0 180.0

-Calibration Offset { *) ~Calibration OFfset { #)

| +[2]

Since different models of servos do not rotate the same amount, a calibration offset allow you to

tune CEENBoT Commander to get close to the 0 to 180 degree range. The Tool Description
window describes how to calibrate your servos.
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Sound:

: The Sound tool produces tones through the on-board speaker using one of
Sound ) three types control: simple beeps, tones or notes. The sound event duration,

250Hz 450ms

time of the tone, and frequency of the tone all can be controlled. Sound

event duration is the entire time spent on the tool, including the time sound is

produced and an optional quiet time.

Simple Beep: If sound type is set to “Simple Beep”, the
tool shows controls for sound event total duration,
active duration (noise making time), and approximate
frequency. Each control can be set using a variable, or
with the tool slider. A simple beep might be used to
signal to a user.

~Saund

Tvpe

| Simple Beep | w |

Tokal Duration (miliseconds)

() Wariable 123 samplevar W
@ Constant
l\_(l )

b bR
0 163533 3706

~Ackive Duration (%)

() Wariable 123 samplevar '
® Constant
0 50 100

Approximate Frequency (Herkz)

() Wariable 123 samplevar ot
@ Conskant
: ] )

0 250 S00
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Tone: If sound type is set to “Tone”, the tool shows
controls for sound event total duration, active duration
(noise making time), and frequency. Duration
controls can be set using a variable, or with the tool
slider. The Frequency control is set in the tool control
window to the desired frequency in Hertz (cycles per
second). A tone might be used to send a more
complex signal to a user, demonstrate the concept of
frequency or Hertz, or play a simple tune.

Note: If sound type is set to “Note”, the tool shows
controls for sound event total duration, active duration
(noise making time), and musical note and octave.
Duration controls can be set using a variable, or with
the tool slider. The Note and Octave control is set in
the tool control window to the desired musical note.

A note might be used to play a song.

~5Sound

Twpe

|Tane

[v]

~Takal Duration (miliseconds)
(=) Wariable 123 samplevar

® Conskank

0 16é83 32%66
hctive Duration (%)

() Mariable 123 samplewvar
® Constant

0 al 100

-Frequency (Hertz)

1,000.5

~Saund

Tvpe

| N_u:ute

-Takal Duration (milliseconds)
() Wariable 123 samplevar
@ Conskant
CJ )

f T ] ]
a 16333 3E7a6

-Aikive Durakion {%s)

() variable 123 samplewvar
& Conskant
-
S ————e
0 50 100
-Maoke
Ockave
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LED:

LEDs © ﬂ

The LED tool is used to control the LEDs. A check indicates which LEDs will be controlled.
The available LEDs vary by platform, so more LEDs are listed than are on the controller board.
The Action drop down allows the LEDs to be illuminated (set), dark (clear) or changed to the
other state (toggle). Toggle is useful for flashing the LED when you don’t know what its

previous state was.

~LEDs

-Selecked LEDs

Enabled

MName

L]
0

ledD
led1
ledz
led3
led4
leds
leds
led?

Select Al

~#ction

Select Mone

Platform | LED |Label | Color
leds || D3 Green
324
leck | D2 Red

Sek

Set
Clear

| Toggle
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Display:
: The display tool is used to show text on the LCD screen. The screen can be
Display = cleared or overwritten when the tool is performed, the line where the text
N | appears can be controlled, and variables can be displayed on the screen.

The value of variables can be printed by entering the
name of the variable with square brackets around it (
‘I in front and a “]” after it). As an example: If the
variable [COUNT] has been set to a value of 10, the
display will show “The value is 10” on the first line of
the LCD screen.

On the Commander Main Screen, display tools can
show a label to help describe its purpose in the
program.

~Display

Clear screen firsk

LZD Text

The wvalue iz [count]

LD Position

Label (20 character ma:x)
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Comment:

The Comment Tool is used to add user comments to the current

[ Your Comment Here ] program.

Comments do not affect the way a program runs, but do allow programmers to leave notes,
hints and other messages within the visual program. Comments can be boxes with rounded
corners, or have an arrow on the left side or the right side of the box.

~izomment
Carmrnent
5
-
‘ Left Arrow Comment
Right Arrow Comment ’
Tvpe

Comments can be used to remind yourself of a problem, question, or description of what a tool
is doing.
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Flow Control Tools ok

Inpuk
Oukpuk
Flaww Conkral

j‘?? Y Branch

-’27 Loop

|:> Gako

| Wariables

o= @

F

Branch:

The branch tool is used when you need a decision to be made based

GnLeft:-l]?f | upon the value of a variable. Note that when comparing an integer with a
SE B constant value, the constant must be in the range -32768 up to 32767.

P If the variable used by the branch is an integer, the tool window allows
E T 2 | test conditions to be set. If the variable is a Boolean, no conditions are
i needed to set true or false.

rBranch Etanch

Wariable 1 _ Yariable 1

| 123 GoLeft | - | 123 samplewar | v |

~_omparison Operakor

~Wariable 2
() Variable 123 samplevar v

® Constant EI
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Loop:

. The Loop Tool will repeat a chain of instructions for a controlled time or
Loop Fﬂ“_ﬁ“ﬂ_ count. Three modes or types are supported: Forever, Count, and

NS  Conditional.

Execute the instructions in the loop continuously. Loop
Tvpe
Forever |v| ]
Loop Count executes loop contents a set number of times
Type or iterations. The number of iterations must be

between 0 and 65535. Note that if you set the count to

Counk w | |0 . .
| | 0, it will not run at all.

Conditional executes loop contents until the value of a ~Loop

variable matches a preset condition. When comparing -Type
an integer with a constant value, the constant must be
in the range of -32768 to 32767.

Conditional | W | 0

Yariable 1

| 173 countdown | W |

-Camparison Operakor

> |v]

~Mariable 2
() Wariable 123 samplesar W

~Loop @ Conskant EI

-Tvpe

Zonditional |v| i
e If the variable for this loop type is a Boolean type, the
Invert Logic checkbox is available. If checked, a
|01 Tooclese |v] logical inversion (NOT) is performed on the variable
Irvvert Logic before it is tested. This is called negative logic.
4
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Goto Tool

The Goto Tool is used to jump to another module in the current program.
;ﬂt" o Once that module chain has been completed, the program flow resumes at the
il " nexttool.

To use the Goto tool, the module must already be created. The module can be changed at any
time. Instructions for creating modules are on page 43.

Goko | &

il luiE neme : Mew_Project_main || MoveCircdes

=)

MoveCircles | W |
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Variables Tools

Math Tool:

samplevar+samplevar+0

Input
Outpuk
Flaww Cankral

Variables

= Math
—

":‘] Random
o) Set

Modules

For example, selecting “+” as an operator and setting
Variable 2 to a constant with a value of 1 will cause
the value of "Variable 1" to increase by 1 each time

the tool is run

Note that variables must not exceed the range of

-32768 to 32767.

The Math Tool is used to mathematically set the value of variables
while the program is running.

~Math
Yariable 1
[v]
Operatars
Yariable 2
() Wariahle 123 samplewar w
@ Conskant |:|
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Random Tool:

The Random Tool allows you to set a variable to an uncertain value between

Rand,m;,-_—;J a minimum and maximum value.
DigeRoll €{1,....8}

e Select the variable you want use to hold
the random value in the "Target Variable"
dropdown box.

e Set the "Minimum" and the "Maximum"
values to the range of values you want
returned. If your "Minimum" value is larger
than your "Maximum" value, the robot will
switch the two values and pick a result
between the two.

Set Tool:

sl
Court Down+<10
v -

~R.andarm

Target Variable

~Minirum Yalue

123 RollDice

|v]

The Set Tool allows values to be assigned to variables.

l\“‘- [ ;I
0 16363 32726
~Maximum Yalue
1
e
1 16364 32TET

Values used in the Set Tool must fall in the range of -32768 to 32767 for integers, and true or

false for Boolean types.

~Sek
Yariable 1
123 countdown | w |
-Wariable 2
() Wariable 123 samplewar wr
@ Constant

~5et

Yariahle 1

-Boolean Yalue

0]1 boal
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CEENBoT Commander Programming Tool Quick Reference

Start is a special tool that CEENBoT Commander creates on all programs. All user
variables are defined here, either as integer or Boolean types.

Input

' % Proximity - Boolean (True / False) assign to a user variable
' Switch - Boolean (True / False) assign to a user variable

"7 Remote - Remote controller input assigned to system variables.

Output

:- Delay - Wait for a while — set through slider, number or variable

> Move - Turn motors and wheels forward, backward or brake — set speed and distance
5 Servo - Rotate servo arms — set servo 0-5 and rotation in degrees or microseconds
& 'jSound - Make sound on speaker with beep, tone or note — set length, pitch or note

= LEDs - llluminate red and green LED — set LED and on or off

EJ
= Display - Show text on LCD screen

& Comment - Make a note on the work space

Flow Control

6 Branch - Control path of program execution based on a variable

;‘? Loop - Repeat a part of the program until a condition is met

a4 Goto - Execution to another program (a module) and return back
Variables

m Math - Add, subtract, multiply and divide, and put the results in a variable

'\-"l
**¥ Random - Generate a “random” number between a low and high number

Set - Put a numeric value into a variable
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Option and Code View Screens:

CEENBoT Commander let you change the appearance of the program and switch the view of
programs you have created from the visual style to their native programming language, C.

B EH S ':‘

1
1. Options

2. View C Code
3. View Graphically

Options

_J|J
T

|

3

=
|
2

The options tab lets you customize CEENBoT Commander for different looks, robot types, and

tools available to use.

Change Target Robot Type.

This option allows choice of Board Type,
Revision and Port. CEENBoT Commander will
be used for other robot types, but for now only
the AVR robot is supported.

You should not need to change these
settings.

Options E|
Target | Tools | Updates || Appearance
Board Type | ANE | w |
Board Revision | | W |
Part | | W |
| | | Read Signature |
ok || cancel
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Enable or Disable Tools

CEENBOT robots can have a number of
accessories like servos installed. Also, in some
cases, it may be helpful to hide tools that are
new or unfamiliar. This option allows selection
or removal of tools that will appear in the Tool
Box

To add a tool, highlight it on the left side and
click <Add>

To remove a tool, highlight it on the right side
and click <Remove>

Click <OK> to record your change

Automatic Check for Updates.

CEENBoT Commander now includes a feature
that at startup, checks the Internet to see if new
versions of the program and other files are
available. You can enable or disable this check
at startup on the “Updates” tab.

Options

Target || Taols | Updates | Appearance

X

The list on the left shows the tools available on this
platform. The tools on the right are those that will be
shown in the User Interface, Mulkiple tools can be selected
by hiolding COMTROL while clicking, and contiguous blocks
af tools can be selected by holding SHIFT while clicking,

Hvailable Toaols Ackive Toaols
meimit-:,.- T EUIIIII:I L8 2l
Switch Lranc
oo
Dielay » ti
a
LEDss Get il
oko
Display B
Sound
Comnent Rand
andari
Branch
Servo
Loop - L ]
e |v] Remote ||
| ok || """ Cancel |
Options §|
Target || Tools | Updates || Appearance
[ check at Startup
ok || cancel |
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Change Appearance.

CEENBoT Commander’s visual appearance
can be changed to your tastes. The size and
color of the main screen grid can be adjusted
and the background color of the screen can
also be changed.

Options E'
Target || Tools | Updates [M'
~iarid

[i'l Shioww Grid % skep Y step
~Background

| Restare Calar defaults |

ok ]| | Cancel
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C Code Screen:

Allows the programmer to see what the visual programming will translate into when the program
is prepared for building. CEENBoT Commander converts your visual programming into the C
programming language before building it and transferring it to the robot. You may find the C
language version of your program an interesting look under the covers. It is not necessary to
understand this screen to use CEENBoT Commander. You cannot make changes on this
screen.

J maM|
S
#* AUTO-GENERATED BEANDT CODE
# Edits will not be saved.
*7
#include "capidZdwiil.h"
#include "gpidZdviil.h"

//global declarations here

int samplewvar = 0;
S/ function prototiypes here

woid CBOT main [ woid )
GPI_MODULES gpi mods;
GPI_CLEAR MODS STRUCT| gpi mods |;

gpi mods.GPI_led = TRUE;
gpi mods.GPI_led = TRUE;
gpi mods.GPI_step = TRUE;
GPI open| &gpi mods );
GPI_END| O };
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View Graphically:

This icon button allows the programmer to return to the graphic screen after viewing the C code
screen.

rmain

=

Sy
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Drop Do

At the top of the CEENBoT Commander window is
a menu of choices, many of which are also

wn Menu

Wign

available in the Icon Bar. Some unique features are under the “Projects” and “Help” tabs.

Projects Dropdown

The “Projects” dropdown contains selections that allow
creation of a new module, adding a library module (an
already written module and included with CEENBoT
Commander), import modules from other sources,

File Edit Wiew  Help

& Add Mew Module. .,

Add Library Module. ..

=+

Import Existing Module. ..
| Selected Module >| Edit Description,. ..
Close Project Properties. ..
& G0 Rename. .,
Build Remaove, .
Clean up
0 Upload

Help Dropdown

The “Help” dropdown contains some options that
are important to using CEENBoT Commander.

=0 Upload

& Add Rew Module, .

Add Library Module. ..
Impart Existing Madule. .
Selected Module »

Close Project

GO
Bivild

Clean up

Project  View

@ About

edit a module already part of this

£ :
;” »| Mew Prolect T hroiect, or close a project.
—

Reference

Software Updates., ..

Restore Firmware >

T r
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Reference

CEENBot Commander Reference Files

Input Tools

All of the tool descriptions are also
available under “Help” >

« ” Cukput Tools
References s

Flaws Control Toaols

B ® #®

Mariable Tools
Cther Tools
Modules

H® &

Select an object to read the help document on it.
For more information about CEEMBoT Commander, visit the
CEEMBCT Commander website at http/fwww. ceenbotine. com/

Manual Check for Updates

CEENBOT Commander will check the Internet  [iiabakaiel s
for new versions of the program and other files.

X

You can run this check manually by clicking
“Help” > “Software Updates”.

Check for updates | |

Cancel
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Restoring CEENBoT Firmware

The CEENBoT Factory Base firmware is programming that provides basic functionality and
battery charging. All CEENBoTSs are shipped with factory firmware, so this allows you to return
your CEENBOT to it’s original programming.

After programming your robot with CEENBoT Commander, you may want to restore the
CEENBOT to the Factory Base firmware. This will be important if you need to charge the battery
on your CEENBoOT.

Other uses for restoring firmware including loading other people’s CEENBoT programs, such as
the graphing calculator control firmware. Also, occasionally, we add features or correct
problems with factory firmware, and you can update your robot using this restore function.

Pre-Upload Checklist

o Be sure to save your current project before restoring firmware onto to the robot.

e Be sure the robot wheels are not touching the floor or table top.

e Be sure the robot is powered on.

o Be sure the AVR Programmer is properly connected to both the computer and robot.
o Be sure the LED closest to the robot on the AVR Programmer is green.

When everything is ready: Select File Edit Project View

Help menu > Restore Firmware > B A H S Reference
Factory Base. Tools Software Updates... B Project main | _
o Input | Restare Firrnware }| Fackary Base
= :Praximit';.-' @ about TI Calculator

CEENBoT Commander Reset to Factory-Default
will ask you to confirm that
you want to do this.

After the firmware is uploaded, the program will start running immediately. Be careful the robot
doesn’t drive off of the table. The CEENBoT can now be used in the basic control mode and
the battery can be charged.
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About

Information about CEENBoT Commander is available
under “Help” > “About” tab, including versions, release

dates,

About CEEMBot Commander

Current developer:

Aaron Mills

Past developers:

Aaron Sharp

Brad Poppe
Eric Day

Icons Designed By

3

Nick Wertzberger

David Gonzalez

Close

About CEENBot Commander, [g|

CEENBoOT
Commander

€ 2011 University of Nebraska
GPI Version 1.2.0RC1
API Version 1.6.0R
1/1j2012

Close

software licensing details.

The programming team and,

About CEEMBot Commander rz

[A]

CEEMEoT Commander Licensing Information
CEEMEQT Commander is licensed under the T
Berkeley Software Distribution (B30 License,
License information is copied into the
CEEMEQT Commander Directory

The CEEMEQT Commander application is builk
upon Java and uses the Substance and RETH
libraries. License information For Java JRE is
presented when and if Java is installed on
vour compuker, Background infarmation .
about Substance and RATH is presented A
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Section 3 — Robot Programming Challenges

Basic Challenges
Movement
Geometric Shapes
e Loops

Modules

Problem Solving
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Programming Challenges

A great way to learn programming is to solve a problem with your program. Below are some
ideas for challenges that will increase your understanding of robot programming. Take the
challenge and create and test programs to perform the following tasks.

Because the robot will start running the program as soon as power is turned on, the robot is
reprogrammed, or the robot is reset, each challenge starts with a 1 second delay. If your
challenge includes motion, be sure to clear space on the floor or tabletop for it.

Basic Challenges

Display a Message:

1. Wait 1 second.

2. Display the message "Hello World!" on the LCD display.
3. Wait 1 second.

4. Clear the display.

Flash an LED:

1. Wait 1 second.
2. Turn on the green LED.
3. Wait 1 second.
4. Turn off the green LED.

Forward Motion:

1. Wait 1 second.
2. Move the robot forward two wheel revolutions.

Spinning Motion:
1. Wait 1 second.

2. Spin the robot 180 degrees. Spinning occurs when the wheels turn in opposite
directions at the same time.

Move In a Circle:

1. Wait 1 second.
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Have the robot follow a circular path. The robot travels in a circle when one wheel turns
more slowly than the other.

Have the robot make a complete circle. This may take trial and error or calculation to
travel 360 degrees.

Move Forward, Return:

1.

2.
3.
4

Wait 1 second.

Move the robot forward two wheel revolutions.
Spin the robot 180 degrees.

Move the robot forward two wheel revolutions.

Move In a Square, Spin:

1.
2.

Wait 1 second.

Have the robot make a square as it moves. One way to think about the motion needed

to make a square is moving straight, then turning 90 degrees, and repeating these steps
three more times.

Have the robot spin 360 degrees when it completes the square.
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Combining Tools to Do More Complex Things

Delay, LED, and Move Tools

Remember that programs start immediately after being downloaded, or after the CEENBoT
power is turned on, or after the reset button is pressed. You may wish to include a delay at the
start of your program so the CEENBoT will wait a second or two before starting to move.

The LED tool can be used to provide visual feedback of the program. You can set (turn on),
clear (turn off), or toggle (change) the red or green LEDs located near the reset button.

The Move tool is one of the more complicated tools since it has many different options and
modes. You can set the direction, distance, and speed of each motor. You can also specify the
run mode as blocking, non-blocking, or freerunning.

Use the Move tool blocking mode when you want the move command to use the full distance
specified, like if you want to make a geometric shape or solve a maze. The sample program
below shows movement with the blocking mode and use of delays and LED changes.

Program Description
1) Start with no variables defined L s b
g
2) Delay 500 milliseconds -
e
3) Set the green LED E | e
—v — Move both forward
4) Move both motors forward 30 deci-revs with a speed of g | ! Fhockim mode
50 and use the blocking mode —
R i« I
5) Delay 500 milliseconds — g '—| Togale both LEDs
LEDs
6) Toggle both LEDs to turn off green and turn on red = :‘::;::::l:de
Move {o
7) Move motors in opposite directions 30 deci-revs with a o
speed of 50 using blocking mode Delay M;
8) Delay 500 milliseconds LE,F(; 1,,,I Clear both LEDs (off)

Move all zero (stop)

9) Clear both LEDs to turn them off Move II“]]I in Blocking mode

10) Move both motors forward 0 deci-revs with 0 speed to
stop the robot even if using non-blocking or freerunning
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Program Challenges
1. Create and test this program using the program description.

2. Modify the program so the second move command will turn the robot around 180 degrees so
that it faces you.

3. Modify the program by adding and modifying move commands at the end so that the robot
will return to the starting point and turn to face the starting direction.

4. Create a new program that will instruct the robot to trace a geometric shape like a triangle or
a square. You could use masking tape to layout the shape on the floor and try to follow the
tape.

5. Create a program to flash one of the LEDs using the Morris Code for SOS, three short
flashes, three long flashes, and then three short flashes again. The robot could also move
about frantically.

Non-blocking Movement

When using the Move tool, you can set the direction, distance, and speed of each motor, and
specify the run mode as blocking, non-blocking, or freerunning. The blocking mode is used
when you want the move commands to use the full distance specified.

Use the non-blocking or freerunning modes when you want other commands that follow the
move command to execute immediately. In non-blocking mode you enter the speed and
distance; in freerunning mode you enter only the speed.

A non-blocking or freerunning move command will operate until another move command occurs.
A delay command following a non-blocking move will cause the delay time to control how long
the move command operates. A move command after the delay acts after the delay time is
done.

The non-blocking move allows you to enter a limiting distance so if the delay time is too long,

the move command eventually stops, the freerunning move runs forever. The sample program
below shows a non-blocking move command that is controlled by a delay command.
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Program Description

1. Start with no variables defined Sha
2. Delay 500 milliseconds ne;;;f =
, . e )
3. Move both motors forward 40 deci-revs with a Move [ Move forward using
speed of 50 using the non-blocking mode | - Han ElocKing mbde
P Py
o Delay
4. Delay 1000 milliseconds . il
N ] )
) Move ﬁ;'ﬁ; Stop previous move
5. With a Move command, set both motors to - b aEr delay tiine
movement of none. b

P &

Program Challenges

1. Create and test this program using the program description.
How far does the robot move? Measure and record your findings in the table below.

2. Modify the delay between the moves to 2000 milliseconds.
How far does the robot move now? Measure and record your findings in the table below.

3. Continue to modify the delay between the move commands to complete the table. Make a
time (X) and distance (Y) graph.

Time Distance
(s) (m)
0 0

a b~ ODND -
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Programming Tasks Using Loops and Modules

Often when programming, the program will need to do something repeatedly forever, or until all
work is done, or until a condition is met. Loops are one way that programmers handle this
need.

In other cases, the same sequence of steps will need to be performed in different places of the
same program. Modules let the programmer write the repeated steps once and use them over
and over.

Loops can be used in a main program or included in a module. Below are examples of how you

can use modules and loops types to solve some programming tasks.

Loop Until a Condition is Met - Wait for a button press

You may want to put a step in your program to make the robot wait until you push a button
before it starts moving. This step can be used in place of waiting 1 second at the start of each
program.

Using a variable, a loop tool, and a switch tool, how can you create a step that waits for a button
to be pressed before continuing?

Loop Forever — Blinking LEDs

£ | blink_mnai
Use a loop to blink the LED lights forever. ’J e
Add a Loop tool set to run forever. Start
Loop -I;nrever
S
(i ; '-\.:_.' i -
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". Blink,_main |

Start

e Add LED and Delay commands to the program. fEop horever

Note that each LED command takes a separate tool :
to turn it on and off.

A

,_
B
wq
@

I

4

Turn LED 5 off
Turn LED 6 on

[

q

B A (ka2

dr

=]
@
=

Turn LED 5 on
Turn LED & off

|

{

When you build and download your program, the robot
flashes its red and green LEDs on and off until you stop it.

LYyl

rgflgfr;
2

{

Counting Loops

A counting loop will use the Goto modules a certain number of times. Add an example of a
counting loop
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Modules

A module is a program within the program. It has the same structure as a regular program
including the Start tool and other tools. What makes it different is that it can be used again and

again in different places.

Using Modules to Move

One use of modules is to repeatedly move the robot a distance using fewer commands.

First create a module called “movement”.

e From the Icon Bar, click the green “+” icon to add a new module to the current project.

BeEHEH S n g B E|@

e Enter the Module name: “movement”.

New Module

Enter new Module name
(use only letters and numbers)

x)

| mu:uvement|

| Ik || Cancel |

¢ Add a Move command to the “movement”
module. Set the move parameters to move
forward 10 deci-revs at 50% speed on both
wheels.

.‘ .
5, Movelt_main || movemenk

s j Move both wheels

Move {[~
o forward
i;_.-; i 10 deci-revs

at 50% speed.
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¢ Add a new module to current project. Enter

the Module name “rewind”.

e Add a Move command to the “rewind”
module. Set the Move parameters move in

reverse 10 deci-revs at 50% speed on both
wheels.

¢ In the main program, put a GoTo tool to

New Module E'

Enter new Module name
fuse only letters and numbers)

|rewin|:|| |

| Ik || Cancel |

‘, Movelt_main | movement | rewind

Mowve both wheels
back

10 deci-revs

at 50% speed.

‘; Mavelk_rain | ravement || remwind |
“movement”, and then a GoTo tool to “rewind”. '

When you build and download your program, the robot will roll forward one revolution, and then

back to where it started.

Using Modules to Make a “U” Turn
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One use of counting loops is to make geometric shapes with fewer commands. This task will
use two modules to turn your robot to face the other direction.

First create a module called “movement”.

o From the Icon Bar, click the green “+” icon to add a new module to the current project.

(d & M| & N g E E| @

e Enter the Module name: “movement”. REwaodule

X

Enter new Module name
(use only letters and numbers)

| mceernent| |

[ Ik || Zancel |

e Add a Move command to the “movement” |§  Movelt_main | movement

module. Set the move parameters to move

forward 10 deci-revs at 50% speed on both - Start
wheels. L= —
" Mowe both wheels

10 deci-revolutions
at 50% speed

e Add a new chain to current project. Enter the

Module name: “turn”. New Module

x]

Enter new Module name
fuse only letters and numbers)

| Furn| |

[ Ik || Cancel |
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*

3 Mowelt_main | movement || turn

¢ Add a Move command to the “turn” module.

Set the Move parameters to forward 10 deci- Start J mbouk st bobee]
ove whee
revs at 50% speed on the left wheel. N
Move jl forward
(8
L ’ 10 deci-revs,
N at 50% speed
e Add the Delay, Loop, and Goto i Movelt_main | movernent | turn

modules to the main module. Set '
the Loop to the Count type that will
run 2 times. Set the Goto A o 185 r
commands to use the oo
“movement” and “turn” modules. ™ 108" e

—‘W_ Loop two times ]

Lunp 2 times &

: 'l«"'" [ Go to the movement module ]
mn\.remer? | I i
"'vvr’ : -
Goto 3 Go to the turn module ]
B turn Bl LY
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Advanced Challenges

Challenge - Robot Geometry

What geometric shape can you make?
Triangle? Square? Star? Circle? Figure Eight?

Challenge - Robot Snow Plow

Create a program to clear the "driveway" of "snow".

The "driveway" is an area 3 feet by 5 feet that is taped off on the floor.

For "snow" use wads of paper or other objects that are randomly added placed on the
"driveway".

You may choose the location to start and when to stop your robot "snow plow".

Hint: If you use paper wads as snow, you may notice the snow gets stuck under the wheels.
You may need to modify the front of the CEENBOT to better push the "snow",
or you can program the CEENBOT to plow the driveway backwards.
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Terms and Acronyms

Atmel — Integrated circuit manufacturer of the microcontrollers used on the CEENBoOT.

AVR - The AVR family of microcontrollers is manufactured by Atmel. Itis one of the first
microcontroller families to use on-chip flash memory for program storage. The CEENBoT
controller board contains two of these microcontrollers

AVRISP mkll Programmer — A device manufactured by Atmel to write programs into the
memory of an Atmel microcontroller. It connects to a PC or Mac type computer with a USB
cable, and to the robot controller with a 6 pin cable.

CEENBoT — An educational robot designed and distributed by the University of Nebraska,
Omaha Campus Computer & Electronics Engineering

CEENBoT Commander - A Graphical Programming Interface (GPI) program that enables drag
and drop visual programming of the CEENBoT. The visual program is turned into a
microcontroller program by Commander, and loaded onto the microcontroller with the AVRISP
mkll programmer.

Firmware — The computer program loaded onto a microcontroller. It is unchanged when power
is turned off.

Flash Memory — A type of electronic circuit that stores binary data for a microprocessor. The
data in flash memory is non-volatile, or unchanged when power is turned off. Microcontroller
firmware is stored in flash memory, and USB thumb drives are based on flash memory.

Infrared Sensors: A device that emits infrared light and detects reflection of the infrared beam
from objects in front of the robot. A common use is to avoid collisions with objects or walls.

ISP - In-circuit Serial Programmer - Supports direct programming of AVR microcontrollers. The
AVRISP mkll Programmer is an example of this.

LCD - Liquid Crystal Display - A digital display that uses an array of liquid crystal cells that
change reflectivity based on the applied voltage. Images and text are presented on the display
to be viewed and read.

Memory — Electronic circuits that store binary data for use by a microprocessor. The data in

non-volatile memory is retained when power is turned off, and is used for program storage.
RAM memory loses its data when power is turned off, and is used for temporary data storage.
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Microcontroller — An integrated circuit containing nearly all parts of a complete computer
system, including the microprocessor, non-volatile memory, RAM memory, and input/output
connections.

PC Board, PCB - Printed Circuit Board - A sandwich of fiberglass and resin covered with
copper sheet. Conductive traces are made using an etching process and mounting holes are
drilled through the board. Integrated circuits and other electronic components are attached by
soldering.

Solder — A metal alloy that melts at a low temperature. It is used to create an electrical and
mechanical connection between wires, PC boards, electronic components and integrated
circuits.

Stepper Motors: A motor that rotates in short, consistent angular movements rather than
turning continuously. The CEENBoT stepper motors turn 1.8° with each step.

USB - Universal Serial Bus - A standard for connecting external devices to a computer. Itis

used for communication, control and power. The AVRISP mkll programmer connects to a PC
or Mac computer through a USB connection.
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